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AKVIS MAKEUP 7.5 | RETOUCH YOUR PORTRAIT PHOTOS!

AKVIS MakeUp improves portraits and adds glamour to photos, giving them a professional look.

 

The software lets you retouching small defects on a skin, making it radiant, beautiful, pure and even, as you can
see on artistic images. It is amazing how much a good complexion adds to rejuvenating and freshening up a look!

Stylish, glamorous photographs have become the hallmark of the fashion industry. But not everyone knows that
before a photo hits the pages of a magazine, it is subjected to thorough processing.

These tricks of professional photographers are now available to everyone!

Just open a portrait with AKVIS MakeUp and click on the Run button. The program will smooth, brighten, and
freshen up the skin without changing other aspects of the photo.
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There are two modes – Express and Advanced. In Express mode, you can do the correction with a single click
using the default settings, while in Advanced mode, you can choose the tone of the skin more precisely using the
eyedropper tool and play with more parameters to find the golden mean between glamour and authenticity.

Additionally to the automatic skin smoothing method, the program also offers some retouching tools like: Spot
Remover, Teeth Whitening, Red Eye Removal, and others.
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You can also achieve some special effects, for example make a B&W portrait or a High Key lighting effect which
blows out harsh shadows and thus removes small imperfections and the shadows under the eyes. The facial
features become well-defined and the portrait appears in the best light.
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AKVIS MakeUp can be useful to the fans of social networks and blogs to improve their profile pictures and add a
touch of glamour to the albums. The software is ideal for processing marriage photographs or graduation
party photos. On such special occasions people try to achieve a perfect result – flawless portraits of the main
participants.

Thanks to the Batch Processing feature, you won't need to process every single picture, but just apply the
chosen settings to the whole folder with the event shooting.

 

AKVIS MakeUp is available in two versions – as a standalone application and as a plugin filter.

The plugin version is compatible with AliveColors, Adobe Photoshop, Photoshop Elements, Corel PaintShop Pro, etc.
Refer to Check the compatibility page for more details.
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INSTALLATION

Follow the instructions to install AKVIS MakeUp on a computer with Windows OS:

Start the setup exe file.
Select your language and press the OK button to launch the installation process.
To continue the installation process you have to read and accept the License Agreement.

Activate the check box "I accept the terms in the license agreement", and press Next.

To install the Plugin, select your photo editor(s) from the list.

To install the Standalone version, make sure that the corresponding option is activated. 
To create a shortcut for the program on desktop, activate Shortcut on Desktop.

Press Next.

Press the Install button.
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The installation is in progress.

The installation is completed.

You can subscribe to the AKVIS Newsletter to be informed about updates, events, and special offers. Enter
your e-mail address and confirm that you accept the Privacy Policy.
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Press Finish.

After installation of the standalone version, you will see the program name in the Start menu and a shortcut on
the desktop, if during installation the corresponding option was enabled.

After installation of the plugin, you will see a new item in the Filter/Effects menu of your photo editor. For
example in Photoshop: Filter -> AKVIS –> MakeUp.
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INSTALLATION

Follow the instructions to install AKVIS MakeUp on a Mac computer:

Open the dmg file:

- akvis-makeup-app.dmg to install the Standalone version

- akvis-makeup-plugin.dmg to install the Plugin into your image editor.

Read the License Agreement and press Agree, if you agree with the conditions.

Finder will open with AKVIS MakeUp application or AKVIS MakeUp PlugIn inside.

 

To install the Standalone version, drag the AKVIS MakeUp app into the folder Applications (or any other
place you like).

To install the Plugin, drag the entire AKVIS MakeUp PlugIn folder into the Plug-Ins folder of your graphic
editor:

Photoshop CC 2020, CC 2019, CC 2018, CC 2017, CC 2015.5: Library/Application
Support/Adobe/Plug-Ins/CC;

Photoshop CC 2015: Applications/Adobe Photoshop CC 2015/Plug-ins;

Photoshop CS6: Applications/Adobe Photoshop CS6/Plug-ins.
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After installation of the plugin, you will see a new item in the Filter menu of your photo editor (in Photoshop:
Filter -> AKVIS -> MakeUp).

Run the standalone program by double-clicking on its icon in Finder.

You can also run the AKVIS program from the Photos app by choosing the Image -> Edit With command (in High
Sierra and later versions of macOS).
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HOW TO ACTIVATE AKVIS SOFTWARE

Attention! During the activation process your computer must be connected to Internet.

If it is not possible, we offer you an alternative way (see below for Offline Activation).

 

Download AKVIS MakeUp and install the program. Read the Installation Instruction here.

When you run the unregistered version, a splash window will appear displaying general information about the
version and the number of days left in your trial period.

You can also open the About the Program window by pressing the button  in the program's Control Panel.

 

Click on TRY IT to evaluate the software. A new window will appear with variants of licenses to test.

You do not need to register the trial version to try all features of the software. Just use the program during the
evaluation time (10 days after the 1st start).

During the test period you can try all options and choose the license you like. Select one of the offered
functionality types: Home (Plugin or Standalone), Home Deluxe, or Business. Your choice of license will affect
which features will be available in the program. Consult the comparison table for more details about license types
and versions of the software.

If the trial period has expired, the TRY IT button is disabled.

 

Click on BUY NOW to choose a license to order.

When the payment is effected, your serial number for the program will be sent to you within minutes.

 

Click on ACTIVATE to start the activation process.
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Enter your name (the program will be registered to this name).

Enter your serial number (your license key).

Choose the method of activation — either direct connection to the activation server or by e-mail.

Direct connection:

We recommend activating the program using direct connection, as it is the easiest way.

At this step your computer must be connected to Internet.

Press ACTIVATE.

Your registration is completed!

Request by e-mail:

In case you have chosen activation by e-mail, a message with all necessary information will be created by
the program.

NOTE: You can also use this method for Offline Activation:

If your computer is not connected to Internet, transfer the activation message to a computer connected to
Internet, for example, with a USB stick. Send us this information to: activate@akvis.com.

Please do not send the screenshot! Just copy the text and save it.

We need your serial number for the software, your name, and HardwareID (HWID) of your computer.

We will generate your license file (MakeUp.lic) using this information and will send it to your e-mail address.

Save the .lic file (do not open it!) to your computer where you want to register the software, in the AKVIS
folder in Users’ Shared (Public) Documents:

Windows 7/8/10:

Users\Public\Documents\AKVIS;

Mac:

AKVIS MakeUp

13

mailto:activate@akvis.com


Users/Shared/AKVIS.

Your registration is completed!

 

When the program is registered, BUY NOW turns to UPGRADE that lets you improve your license (for example,
change Home to Home Deluxe or Business).
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WORKSPACE

AKVIS MakeUp can work independently as a standalone program as well as a plugin to a photo editor.

Standalone is an independent program; you can open it by clicking on the program's icon.

To launch the standalone version, run the program directly:

On a Windows computer - select it from the Start menu or use the program's shortcut.

On a Mac computer - launch the app from the Application folder.

Plugin is an add-on for a photo editor, for example for Photoshop.

To call the plugin, select it from filters of your image editing program.

The workspace will be arranged according to the interface mode chosen in the Control Panel: Express,
Advanced, or Presets.

The first time you run the program, it is displayed in Express mode, with a simplified interface and a minimal set of
sliders, which help to quickly obtain a satisfactory result.

Workspace of AKVIS MakeUp (Express)

Experienced users who are familiar with the capabilities of AKVIS MakeUp can switch to Advanced mode: the
interface's appearance will change, granting access to the full functionality of the program.

Note: All features and parameters work in Express mode as well; some are hidden and the program uses values of
a chosen preset.
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Workspace of AKVIS MakeUp (Advanced)

The Presets button in the top panel allows you to switch to the visual display mode of presets (Presets Gallery).
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Workspace of AKVIS MakeUp (Presets Gallery)

 

The left part of the program's window is taken by the Image Window with two tabs - Before and After. The
Before tab shows the original image, the After tab shows the result. To switch between the tabs and compare
the original and the resulting images, just left-click on any point of the image.

Keep in mind that once the After tab is pressed, the entire image will be processed automatically.

You can select how Image Window and Before/After tabs will be shown by adjusting the View Modes in the
bottom part of the left panel.

 

In the upper part of the program's window you can see the Control Panel with the following buttons:

The button  opens the home page of AKVIS MakeUp.

The button  (only in the standalone version) opens an image for processing. Right mouse click on this

button displays the list of recent files. You can change the number of recent documents in the Preferences
dialog box.
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The hot-keys are Ctrl+O  on Windows, ⌘ +O  on Mac.

The button  (only in the standalone version) saves image to the disk. The hot-keys are Ctrl+S  on

Windows, ⌘ +S  on Mac.

The button  (only in the standalone version) prints the image. The hot-keys are Ctrl+P  on Windows,

⌘ +P  on Mac.

The button  (only in the standalone version) opens the Batch Processing dialog to automatically

process a series of images.

The button  lets posting pictures from the program to the social networks.

The button  imports a list of user presets (from the .makeup file).

The button  exports user presets. You can save any presets to a .makeup file.

The button  cancels the last operation made with the tools. It is possible to cancel several operations in

a row. The hotkeys are Ctrl+Z , on Windows, ⌘ +Z  on Mac.

The button  returns the last cancelled operation. It is possible to return several operations in a row. The

hotkeys are Ctrl+Y  on Windows, ⌘ +Y  on Mac.

The button  starts image processing. The result is shown in the After tab.

The button  (only in the plugin version) applies the result to the image and closes the plugin.

The button  calls information about the program.

The button  calls the Help files. The hot-key is F1 .

The button  calls the Preferences dialog box for changing the program's options.

The button  opens a window showing the latest news about MakeUp.

 

Тo the left of the Image Window there is the Toolbar. Different tools will appear, depending on the workspace
mode Express/Advanced chosen. The tools' parameters are shown in the Settings Panel and in a pop-up box
after right-clicking in the image window.

Pre-Processing Tools (in the Before tab):

The button  switches on/off the Quick Preview area (more…).

 

Mask Correction Tools (available for Home Deluxe and Business licenses):

The button  activates the Keep Area tool which adds fragments to the tone mask.

The button  activates the Drop Area tool which removes fragments from the tone mask.

The button  activates the Eraser which removes the manual corrections made in the mask, returning to

its original form (the auto-mask).

 

Retouching (Post-Processing) Tools (available in the After tab):

Attention! If you switch to the Before tab, adjust the parameters and run the image processing again ,

the changes made with these tools will be cancelled; but they can be restored with the successive use of 

.

You can use these retouching tools:
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The button  activates the Teeth Whitening tool.

The button  activates the Red Eye Removal tool.

The button  activates the Spot Remover tool which removes small imperfections on an image: stains,

dust, etc. You can also use it to retouch portraits. It can "heal" skin problems. Just click with the tool on the
defect.
The button  activates the Chameleon Brush tool.

The button  activates the Blur tool which reduces image sharpness by decreasing color contrast

between neighboring pixels.
The button  activates the History Brush tool which restores areas to their original state. It lets you

edit the result without correcting a mask.

 

Additional Tools:

The button  (only in the standalone version) activates the Crop tool which allows cutting off unwanted

areas in the image.
The button  activates the Hand tool which allows you to scroll the image when it does not fit within

Image Window at the desired scale. To use it click on the button, bring the cursor over the image, and
while keeping the left mouse button pressed move in the desired direction.
Double-clicking on the tool's icon  on the Toolbar makes the image fit the Image Window.

The button  activates the Zoom tool, which changes the image's scale. To zoom in left click on the

image. To zoom out left click with Alt  on the image. Press Z  to quickly access the tool.

Double-clicking on the tool's icon  on the Toolbar makes the image scale to 100% (actual size).

 

On the right side of the program's window you can see these sections: Navigator; Parameters; Hints.

You can hide/show a section by clicking on its title.

 

Navigate and scale the image using the Navigator. The frame in the Navigator surrounds the area of the image
which is visible in the Image Window; the area outside of the frame will be shaded. The frame can be dragged,
thereby changing the visible portion of the image. To move the frame, place the cursor within it, left click the
mouse, and then drag.

Additionally, you can move the image in the Image Window with the scroll bars or by holding down the space bar,
then holding down the left mouse button while moving the mouse. The mouse's scroll wheel can move the image
up and down, and holding Ctrl  (⌘  in Mac) – while using the scroll wheel will move the image left and right.
Holding Alt  (Option  in Mac) will scale the image. Right-click on the scroll bar to activate the quick navigation

menu.

Use the slider or the buttons  and  to scale the image in the Image Window. When you click on the  button
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or move the slider to the right, the image scale increases. When you click on the  button or move the slider to

the left, the image scale reduces.

You can also change the image scale by entering a new coefficient into the scale field. Frequently used scale
coefficients can be found in a drop-down menu.

You can use hot-keys to change the image scale +  and Ctrl++  (⌘ ++  in Mac) to increase the image scale and

-  and Ctrl+-  (⌘ +-  in Mac) to reduce the scale.

 

On the right side, there is the Settings Panel with the image processing parameters grouped into three tabs:
Smoothing, Correction, and Effects; and the list of the Presets for these settings. Below there are the options
for the selected tool.

In the bottom part you can see Hints for the parameters and buttons when you hover over them with the cursor.
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IMAGE VIEW MODES: BEFORE AND AFTER

At the bottom of the Toolbar of AKVIS MakeUp, there are three buttons which let you choose how the Image
Window will look like and arrange the Before and After tabs.

Click the first button to open a submenu that contains various options for viewing the original and processed
images:

- The button  provides the standard image window mode with two tabs: Before and After.

- The buttons  and  divide the main window into two parts, vertically or horizontally,

respectively. The original and processed images become partially visible and the tabs are combined to
form the whole picture.

With this arrangement, it's possible to drag the splitter changing the aspect ratio between the Before
and After parts.

- The buttons  and  split the main window into two parts, vertically or horizontally, as well.

However, in contrast to the previous option, the windows display the same fragment of the image
before and after processing.
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Note: Use two windows side by side when you want to see and compare the original and processed versions
of an image fragment on one screen. If you would rather see the final image as a whole, you can choose the
standard image view mode.

The button  swaps the positions of the original image and result when displaying two windows.

The 3rd button lets you choose the background color of the Image Window. Pressing , , or 

changes the background color to white, gray, or black, while clicking on  opens the Select Color dialog

where you can choose a color of your choice.
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HOW IT WORKS

AKVIS MakeUp improves portraits and adds glamour to photos, giving them a professional look. The software lets
retouching small defects on a skin, making it radiant, beautiful, pure and smooth as you can see on highly artistic
images.

You can get a result with AKVIS MakeUp quickly and easily. It saves you from the long and laborious task of
several stages (manipulating layers, masks, textures, filters, blur and noise, and blending modes).

Cover Face

AKVIS MakeUp can run as a standalone program and as a plug-in in a graphics editor.

Follow these steps to improve an image in AKVIS MakeUp and give it a more glamourous look:

Step 1. Open an image.

- If you work with the standalone edition:

The dialog box Select File To Open appears if you double-click on the empty workspace of the

program or if you click on the button  on the Control Panel. You can also drag the required image

into the workspace of the program.

The Standalone edition of AKVIS MakeUp supports RAW, JPEG, PNG, BMP, and TIFF file formats.

- If you work with the plugin:

Open an image in your photo editor by calling the command File -> Open or using the key combination
Ctrl+O  on Windows, or ⌘ +O  on Mac.

Call the AKVIS MakeUp plugin:

In AliveColors: Effects -> AKVIS -> MakeUp;
in Adobe Photoshop: AKVIS -> MakeUp;
in Corel PaintShop Pro: Effects -> Plugins -> AKVIS -> MakeUp;
in Corel Photo-Paint: Effects -> AKVIS -> MakeUp.

Step 2. The workspace will be arranged according to the interface mode chosen in the Control Panel:
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Express, Advanced, or Presets.

Workspace of AKVIS MakeUp

When an image is loaded into the program a face mask is created automatically. This mask is used during the
skin correction process. By default, the tone mask is invisible. To make it visible switch in the Show Mask
modes.

You can edit the auto-mask by selecting colors on a portrait with the eyedropper or using the mask
correction tools , , . Learn more about the mask correction tools in this example.

 

The result will be shown in the Before tab in the Quick Preview window which is represented by a dotted
frame. You can drag the frame or draw it anew on any part of the image, thus analysing different parts of
the photo.

To compare the processed sample with the original photo, left-click on the image within the preview area.
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Quick Preview

It's possible to change the size of the quick preview area in the program's Preferences .

Step 3. If you are not happy with the automatic result, change the settings and/or manually modify the
mask.

The parameters in the Settings Panel are grouped into three tabs: Smoothing, Correction, and Effects.

Smoothing tab. These parameters help to improve an image by eliminating small defects. They affect
the selected area (tone mask).
Correction tab. The parameters in this tab offer additional ways of image processing (Sharpness,
Brightness, Contrast, and other standard settings). They affect the entire image.
Effects tab. Here you can apply creative effects (Glamour Glow and Vignette) to change the mood
of your picture and make it look more magical, romance, or dramatic. They affect the entire image.

Step 4. To process the entire image, click on  or on the After tab. After processing it is possible to

switch between tabs by pressing the left mouse button on any point of the image.

Without Effects Adding Effects
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Processing Result

Step 5. It is possible to save the settings you like as a Preset to use them in the future. The presets are
also helpful when working in the Batch Processing mode. Learn more about the MakeUp Presets.
Step 6. You can also make final touches and correct the result in the After tab using the retouching tools: 

, , , , , .

Step 7. Share your portrait by clicking on . It lets you publish the image from the program to the social

networks.

In the standalone version you can also print the image with .

Step 8. Save the processed image.

- If you work with the standalone edition:

Click on the button  to open the Save as dialog box. Enter a name for the file, choose the format

(TIFF, BMP, JPEG or PNG) and indicate the target folder.

- If you work with the plugin:

Apply the result by pressing . The AKVIS MakeUp plugin will close and the picture will appear in

the workspace of the photo editor.

Call the Save As dialog box using the command File -> Save As, enter a name for the file, choose
the format and indicate the target folder.
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SKIN SMOOTHING

In Smoothing tab, you can improve a portrait by removing small imperfections on the skin. The program
intelligently recognizes the face on a photo and creates a mask with the skin tone areas. It's possible to modify
the tone mask to only the areas you want to process.

Hint: To enhance the effect, edit the tone mask using the Keep Area tool . Find more information about the

mask correction tools here.

 

Adjust the Smoothing settings:

Smooth Level (0-30). The parameter evens the skin texture. Small details are preserved.

Blur (0-50). The parameter sets the level of blurring. The higher its value, the blurrier the skin texture is and
the less small details are kept.

Large Defects (0-100). Increase the parameter to smooth large irregularities (works on the manually
created tone mask).

Smooth Level = 0 Smooth Level = 30

Blur = 0 Blur = 50
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Skin Texture (0-40). The parameter adds some noise to the skin for a more natural look.

Fade (10-100). The parameter blends the mask with the source image. The smaller the value, the more
pronounced the original skin texture appears.

 

Tone Mask

There are two ways to create a tone mask: Auto and Manual. In the first method the program detects the area
of the face automatically, while the second method requires you to manually select the skin color which the
program will use as a basis for creating the mask.

You can enable the Keep Colors check-box to use this color set for all presets.

Large Defects = 0 Large Defects = 100

Skin Texture = 0 Skin Texture = 20

Fade = 20 Fade = 100
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Creating a Mask

When an image is loaded into the program a face mask is created automatically. This mask is used during the skin
correction process. By default, the mask is Invisible. To view the mask on a White, Black,  or Transparent
Background, select the appropriate option from the drop-down list.

Mask View Modes

 

Making the mask visible allows you to see exactly where processing will be applied, and the mask correction tools 
, ,  become accessible.

 

You can manually modify the auto-mask by choosing colors on the portrait with the eyedropper.

Left-click over one of three square cells. The cell will then contain a dotted selection, and when the cursor is
dragged over the image it will take the form of a eyedropper.

To select a color just click with the eyedropper over the face. Double left-clicking over a cell opens the color
selection dialog. Right-clicking a cell removes its color.

For Deluxe and Business licenses, it's possible to edit the mask with the tools (example):

Keep Area tool  adds fragments to the tone mask.

Drop Area tool  removes fragments from the tone mask.

Eraser  cancels the manual corrections made in the mask with the above mentioned tools, returning it to

the original form.

The tools' option:

- Size affects the tool's diameter.
- Hardness affects the blurriness of the tools edges. The less the value the more blurry the tool's edges
become.

Mask on a White Background Mask on a Black Background Mask on a Transparent
Background
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- Pressure affects the force of the tool applied to the image.

Adjust the Tone Mask parameters:

Density (0-100) affects the number of pixels stored in the mask.

Color Range (0-100) changes the number of colors used in the mask.

Density = 10 Density = 90

Color Range = 10 Color Range = 80
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Feathering (0-100) smoothes the edges of the mask to enhance the transition between treatment zones.

 

Feathering = 0 Feathering = 90
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IMAGE CORRECTION

The parameters in the Correction tab in AKVIS MakeUp offer additional ways of image processing. They affect
the entire picture. You can adjust these standard settings to improve the photo:

 

Sharpness (-50 to 50) adjusts the clarity of the image by changing the contrast of adjacent pixels. Values
in the negative range smoothen the image while values in the postive range sharpen it.

Brightness (-100 to 100) affects how the image is illuminated. At higher values the image is brighter while
at lower values it is darker.

Contrast (-50 to 50) increases (at values greater than 0) or decreases (at values less than 0) the
difference between light and dark areas of the image.

Hue (-100 to 100) is used to change the color tone.

Sharpness = -40 Sharpness = 40

Brightness = -40 Brightness = 40

Contrast = -50 Contrast = 35
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Saturation (-100 to 100) changes the intensity of color from a neutral gray to the brightest color.

 

Hue = -20 Hue = 20

Saturation = -50 Saturation = 50
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EFFECTS: GLAMOUR GLOW AND VIGNETTE

Using the Effects tab in AKVIS MakeUp you can apply creative effects (Glamour Glow and Vignette) to change
the mood of your picture and make it look more magical, romantic, or dramatic.

 

The Glamour Glow effect adds a soft glow effect by creating a blurred layer above the image. When these layers
are blended together it results in a surreal appearance. The effect gives a feeling of elegance and grace, and even
dreaminess.

Intensity (0-100) defines the strength of the glow effect.

 

The Vignette effect lets you lighten or darken the edges and draws your attention towards the central part of
the image.

Dark/Light Edges (-100 to 100). This parameter determines how much the edges will be darkened or
lightened. At negative values edges are darkened, while positive values lighten the edges.

Distance (0-100) determines how far from the center of the image shading will begin.

Intensity = 5 Intensity = 80

Dark Edges (-50) Light Edges (95)
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Shape (-100 to 100) affects the form of the unshaded area of the image. At negatives values it takes the
form of a rectangle with rounded edges, while at positive values it takes the form of a circle.

Distance = 0 Distance = 50

Shape = -50 Shape = 50
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Smooth Transition (0-100) adjusts the smoothness of the boundary between the shaded area and the
central part. Increasing the value increases the fading effect.

Position. Move the white marker to shift the vignette. You can see the current coordinates of the center in
the X and Y fields.

Moving Vignette

 

Smooth Transition = 10 Smooth Transition = 50
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RETOUCHING TOOLS

AKVIS MakeUp also offers the post-processing tools which can be applied on the After tab. These retouching
tools helps to make final touches and correct the result: , , , , , .

 

Retouching Tools:

The Teeth Whitening tool  lets you make the teeth whiter. Apply the tool to the image, it will lighten

the areas finding edges. The effect is increased with each successive brush stroke.

The tool can be also used to process the whites of eyes.

You can adjust these parameters for the tool:

Size (20-200) affects the tool's diameter.

Smoothing (0-10) affects the degree of the edge softness of the stroke.

Tolerance (0-100%) determines the sensitivity of the tool: the stronger the value, the more areas are
changed.

Strength (10-100%) defines the how much the image will be whitened.

 

The Red Eye Removal tool  lets you correct the red eye defect.

You can change the tool's Size (10-300).

 

Fragment of the Original Image Using the Teeth Whitening Tool

Fragment of the Original Image Using the Red Eye Removal Tool
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The Spot Remover tool  removes small imperfections and "heals" skin problems. Just click with the tool

on the defect to remove it.

You can change the Size (7-200) for this tool.

 

Chameleon Brush  copies parts of an image from one area to another, while taking into account the

color palette, shadows, textures, lighting, and other characteristics of the background, onto which the clone
is placed. This tool preserves the texture of the image.

Tools' options:

Size (10-500) - diameter of the brush.

Aligned check-box. You can select the cloning method using the Aligned option. When the check-box
is activated, a single clone will be created using information from around the selected source: in this
case each time the left mouse button is pressed a clone will be selected from the relevant area. When
the check-box is disabled, each time the mouse button is released the cursor returns to the source
area, and new clone fragments are created from the same area.

Flip Horizontal. This option allows a clone to be mirrored along the standing axis, i.e. interchanging
the left and right sides.

Flip Vertical. This option mirrors a clone by turning the image upside down.

Scaling (20-400%). The size of the clone relative to the original fragment.

Fragment of the Original Image Using the Spot Remover Tool
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The Blur tool  reduces image sharpness by decreasing color contrast between neighboring pixels.

You can adjust these parameters for the tool:

Size (1-200) affects the tool's diameter.

Hardness (0-100%) defines the blurriness of the tool's edges. The less the value the more blurry the
tool's edges become.

Radius (0.1-5.0) determines the intensity of the effect on an image. It specifies the area of the
points for blurring: at higher values the blurring radius is larger.

The History Brush  restores areas to their original state.

You can adjust these parameters for the tool:

Choose between the restoration modes: Restore to Original/Edit Brushes:

- 1st mode lets you return to the original state. It helps to edit the result without correcting a
mask.
- 2nd mode lets you correct the result of the post-processing brushes keeping the effect
achieved at the initial stage.

Fragment of the Original Image Using the Chameleon Brush

Fragment of the Image Blurring
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Size (1-2000) affects the tool's diameter.

Hardness (0-100%) defines the blurriness of the tool's edges. The less the value the more blurry the
tool's edges become.

Strength (1-100%) affects the degree of restoration to the original state.

 

Original Image Using the History Brush
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BATCH PROCESSING

AKVIS MakeUp supports batch processing, i.e. the possibility to automatically process a series of images with
the same settings.

Batch processing is useful when dealing with a lot of photos taken under the same conditions with identical camera
settings or to achieve a similar effect. The feature is ideal for improving marriage photographs or graduation party
photos. You won't need to process every single picture, but just apply the chosen settings to the whole folder
with the event shooting.

Using batch processing is simple! See Video Tutorial.

 

Even if you've never used this feature before it is simple to learn!

If you use the standalone version of AKVIS MakeUp, read the instructions here.

If you use the MakeUp plugin in Photoshop, use this tutorial.
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BATCH PROCESSING WITH PHOTOSHOP PLUGIN

The AKVIS plugins support the automation feature in Adobe Photoshop.

Batch processing is very useful and time saving when you have to apply the effects to a number of photos. This
method applies the same settings to a folder full of images.

Even if you have never used batch processing you will find no difficulties in understanding it. First you create an
Action in Photoshop and then apply it to a photo folder.

Follow the instructions:

Step 1. Create two new folders, for example: "source-files" and "result-files". Place original images into the
"source-files" folder. The results will be saved in the "result-files" folder.
Step 2. Open one of the original images in Adobe Photoshop. We will use this photo to adjust the plugin's
settings and create an action.

Step 3. In the Actions palette click Create New Set button. In the dialog window give a name for a new
set of actions, for example, "AKVIS Actions".

If you already have a special set for the AKVIS actions, you can just choose it.

Actions Palette

Step 4. Press Create New Action and give a name for it, for example, "Neon".
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New Action

Press the Record button, and the recording of the action will immediately start.

Step 5. Call the plugin and adjust its parameters.
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Step 6. Press the button . The plug-in window will close and the effect will be applied to the image. In

the Actions palette, in your new action, you will see a new line with the plugin's name.

Step 7. Remember that the action is still being recorded. Now, you should save the image. Choose Save As
in the File menu and save the image into the destination folder.
Step 8. Stop the action recording by pressing Stop playing/recording at the bottom of the Actions
palette.
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Step 9. Delete the file that you have just saved.
Step 10. The action is created and you can proceed to batch processing of the photos.

In the File menu of the editor choose Automate -> Batch.

Step 11. In the Batch dialog window and set the parameters:
In the Set drop-down list choose "AKVIS Actions" and the new action.
In the Source option set Folder. Press the Choose… button and select "source-files".
As the Open command was not recorded in the action, the Override Action "Open" Commands
check-box should be deactivated.
For Destination select Folder, then press the Choose… button and select "result-files".
Activate Override Action "Save as" Commands check-box.
In the File Naming section you can create the filenames structure for the resulted images. If you do
not want to change the names, in the first combo-box choose document name, and in the second -
extension.

Step 12. Press OK to start processing. Photoshop will apply the AKVIS plugin to all photos in the "source-
files" folder, one by one, and will save them to the "result-files" folder.

 

AKVIS MakeUp

45



MAKEUP PRESETS

AKVIS MakeUp includes a number of ready to use skin retouching presets which help you start working. When
moving a cursor over a preset in the drop-down list, the quick result appears in the small window on the left side
of the list.

To process the entire image using a preset, select it from the list and click on .

A preset contains the settings of all tabs.

You can apply one of the AKVIS presets or modify the parameters to achieve the desired result.

To create your own preset, type a name for the preset into the field and press Save.

To return to the default settings of the selected preset, click on Reset.

To delete your preset, choose it from the drop-down list and press Delete. The AKVIS built-in presets cannot be
removed.

 

Next to the preset name field there is a heart icon. Click on it to add the selected preset to Favorites or to
remove it from this group of presets.

 

Presets Gallery

Click on the Presets button in the top panel to switch to the visual display mode of presets with the live preview.
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Presets Gallery

You will see a list of presets sorted alphabetically (AKVIS presets) or by creation date (user presets). When an
image is loaded into the program, preset thumbnails are generated.

Click on a thumbnail to select the preset. Double-click on the thumbnail starts processing the entire image.

Double-click on the name of the user preset to rename it. The AKVIS built-in presets cannot be renamed.

Use these buttons to change the display of presets:

 - to show AKVIS Presets;

 - to show User Presets;

 - to show presets marked as Favorites.

Presets thumbnails can be arranged in two ways:

 - as a vertical list;

 - filling in the entire program area.

The preset control buttons are duplicated by the context menu commands:

 Add to Favorites /  Remove from Favorites;

 Rename Preset (only for user presets);

 Move Up (only for user presets);
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 Move Down (only for user presets);

 Delete Preset (only for user presets);

 Show Parameters.

 

It's possible to export and import user presets (a file with the .makeup extension) using these buttons:  and 

. 

Read more about import and export user presets.
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PROGRAM PREFERENCES

The button  opens the Preferences dialog box. It looks like this:

Language. Change the program language by selecting another from the drop-down list.
Interface Scale. Choose the size of the interface elements. When it is set to Auto, the program workspace
will automatically scale to fit the screen resolution.
Interface Theme. Select the style of the program interface: Light, Gray or Dark.
Preview Window Size. You can change the size of the quick preview area: from 200 х 200 to 1,000 х 1,000 
pixels.
Initial Image Scale. This option defines the way the image is scaled in the Image Window.

- Fit to View: the image is completely visible in the window;
- 100%: the image doesn’t scale (generally, only a part of the image is visible).

Hints Panel. You can choose how the hints will be shown:

- Under Image Window;
- Under Settings Panel;
- Hide.

Recent Files (available only in the standalone version). The number of recent documents. The list of the

recent files, sorted by time, become visible by right mouse clicking on . Maximum: 30 files.

Use OS File Dialog check-box. You can check this option if you want to use the System Open/Save Dialog.
By default, the AKVIS File Dialog is used.
Lock the Control Panel check-box. It disables the possibility to hide/show the top panel. If the check-box
is selected the panel is always visible. Uncheck the option to unlock the panel, and you will be able to
hide/show it by clicking on the small triangle button (in the middle of the panel). The minimized panel will be
shown when moving the cursor over it.
Use GPU. The check-box lets you turn on GPU acceleration. If your computer does not support GPU
acceleration the check-box will be disabled.

To save changes made in the Preferences window press OK.

If you need, click on the button Default to come back the default settings.
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PRINT IMAGES IN AKVIS MAKEUP

In the standalone version of AKVIS MakeUp you can print the image. Press the button  to open the Print

options.

Print Options in AKVIS MakeUp

Adjust the parameters appearing in the Settings Panel:

Choose a printer from the list of available devices, set the desired resolution, as well as the number of
copies to print.

In the Orientation group, set the position of paper: Portrait (vertically) or Landscape (horizontally).

Click the Page Setup button to open a dialog box to choose the size of the paper and its orientation, as
well as the print margins.

Press the Reset Margins button to return the page margins to the default size.

Change the size of the printed image adjusting the parameters Scale, Width, Height and Fit to Page.
These parameters have no effect on the image itself, just on the print version. You can change the size of
the printed image by entering any value in %, or by entering new values in Width and Height.

To adjust the size of the image to the paper size, select Fit to Page.

Move the image on the page with the mouse or align it using the arrow buttons.

You can activate Frame for the image and adjust its width and color.

Choose the Background Color by clicking on the color plate.

In the Page tab, you can adjust printing of the multiple copies of the image on a single sheet.
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Print Page

Copies per Page. It lets you specify the number of copies of the image on one page.
Horizontally and Vertically. These parameters indicate the number of rows and columns for the
copies of the image on the page.
Spacing. The parameter sets the margins between the copies of the image.

In the Poster tab, it's possible to customize printing of the image on multiple pages for the subsequent
junction into a large picture.
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Print Poster

Pages. If the check-box is enabled, you can specify the maximum number of the pages in which the
image will be divided. The image scale will be adjusted to fit this number of the sheets. If the check-
box is disabled, the program will automatically select the optimal number of the pages in accordance
with the actual size of the image (scale = 100%).
Glue Margins. If the check-box is enabled, you can adjust the width of the padding for bonding
sheets. Margins will be added to the right and to the bottom of each part.
Lines of Cut. Activate the check-box to display the cut marks in the margins.
Show Numbers. With the enabled check-box, a sequence number of each part, by a column and a
row, will be printed in the margins.

To print the image with the chosen parameters, press the Print button. 
To cancel and close the printing options click on Cancel.

Click the Properties... button to open a system dialog box that enables you to access the advanced settings and
send the document to print.
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HIGH KEY PORTRAIT

High Key photography is a technique with white light falling evenly on all objects in a scene. High Key
photographs contain tones from light gray to pure white. In these photos the eyes, eyelashes and facial contours
are accentuated. Such portraits are characterized by the absence of heavy shadows and details.

Creating a High Key portrait is typically a complicated process in which the subject is illuminated in white
reflected light from the surface of three sources. This tutorial will show how a high key portrait can be created in
just a few minutes with AKVIS MakeUp.

Step 1. Open an image in AKVIS MakeUp.

Original Image
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Step 2. To create a high key portrait, first click on the Correction tab and choose the appropriate
parameters.

Turn down Saturation and increase Brightness so that a small amount of color remains in the image, and
grey areas are brightened. The Hue parameter, as a rule, should be shifted slightly to cooler tones.
Sharpness should be weakened to soften the image. Finally, change Contrast.

Correcting the Image in AKVIS MakeUp

Step 3. Start processing the entire image by pressing .
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Result After Processing

To strengthen the effect you can add an artificially bright white background:

High Key Portrait
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IMPROVING SKIN TONE

Women have always tried to look more beautiful. One of the most important aspects of make-up is to achieve a
smooth and even skin complexion. Usually this is achieved with foundation, which gives the skin a certain color. If
you don't have any foundation on hand, AKVIS MakeUp can deal with this task wonderfully.

Step 1. Open an image.

Original Image

Step 2. The default settings are sufficient for smoothing the skin.
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Fragment of the Original Image After Smoothing

Step 3. During the second phase of work a glamorous look will be created using the correction parameters.
To access them, switch to Advanced mode, click on the Correction tab, and adjust the settings.

Correcting the Image in AKVIS MakeUp

Step 4. Process the entire image by pressing .
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Final Result
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AKVIS PROGRAMS

 

AKVIS AirBrush — Airbrushing Techniques on Your Photos

(Windows | Mac)

AKVIS AirBrush automatically transforms a photograph into a work of art which looks like made with a special
airbrush tool that sprays paints or inks. The software works as an artistic filter creating stylish colorful airbrush
designs from images using chosen settings of photo-to-painting conversion. More…

 

AKVIS ArtSuite — Frames and Effects for Your Photos

(Windows | Mac)

AKVIS ArtSuite is an impressive collection of versatile frames and effects for photos. ArtSuite contains many
templates and texture samples that can be used to create a virtually limitless variety of options for generating
frames.
Decorate a photo to give it an original and festive look! More…
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AKVIS ArtWork — Collection of Painting & Drawing Techniques

(Windows | Mac)

AKVIS ArtWork is photo to painting software designed to imitate different painting techniques - Oil Painting,
Watercolor, Gouache, Comics, Pen & Ink, Linocut, Pastel, and Pointillism. ArtWork helps you to create a piece of
art out of any picture! More…
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AKVIS Chameleon — Photo Collage Creation

(Windows | Mac)

AKVIS Chameleon is a fun to use tool for photo collage creation. It makes the process easy and entertaining.
The tool is very easy to handle as it does not require precise selection of objects.
Using the software you can quickly create your own photo collages. More…

 

AKVIS Charcoal — Charcoal & Chalk Drawings

(Windows | Mac)

AKVIS Charcoal is a creative tool for conversion of photos into charcoal and chalk drawings. Using the program
you can make professional-looking expressive black and white images. Playing with colors and options you can
achieve outstanding artistic effects, such as sanguine and others. More…

 

AKVIS Coloriage — Add Color to Black and White Photos

(Windows | Mac)

AKVIS Coloriage allows colorizing B&W photos and replacing colors in color images, performing selective
colorization and desaturation. It helps to breathe new life into your old family photographs, bring a vintage or
artistic appearance to your digital images. More…
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AKVIS Decorator — Resurface and Recolor

(Windows | Mac)

AKVIS Decorator lets you change the surface of an object in a realistic manner. The program puts on a texture
keeping the volume of an object, following its folds and creases. The new pattern looks absolutely natural and
makes you see things differently. Recoloring is also made easy. More…

 

AKVIS Draw — Hand-made Pencil Drawing Effect

(Windows | Mac)

AKVIS Draw converts your photos into hand made pencil drawings. The software creates realistic looking line art
illustrations, produces both B&W and color drawings. Add a hand-drawn look to your pictures! More…
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AKVIS Enhancer — Bring Detail To Your Pictures

(Windows | Mac)

AKVIS Enhancer is image enhancement software that detects detail in underexposed, overexposed and mid tone
areas of a photo with uneven exposure. Enhancer improves every part of the image! The software works in three
modes: Improve Detail, Prepress, and Tone Correction. The program offers a fast method to fix a dark photo, add
contrast and brightness to a picture, it lets you improve color and adjust tones. More…

 

AKVIS Explosion — Fabulous Particle Explosion Effects

(Windows | Mac)

AKVIS Explosion offers creative destruction and particle explosion effects for your photos. It bursts an object
and applies dust and sand particles to an image. With the software, you can create eye-catching graphics in just
a few minutes! More…

 

AKVIS Frames — Decorate Your Photos with Frames

(Windows | Mac)

AKVIS Frames is a free program designed for working with the AKVIS frame packs

AKVIS MakeUp

63

https://akvis.com/en/enhancer/index.php?utm_source=help
https://akvis.com/en/enhancer/index.php?utm_source=help
https://akvis.com/en/enhancer/index.php?utm_source=help
https://akvis.com/en/explosion/index.php?utm_source=help
https://akvis.com/en/explosion/index.php?utm_source=help
https://akvis.com/en/explosion/index.php?utm_source=help
https://akvis.com/en/frames/index.php?utm_source=help
https://akvis.com/en/frame-packs/index.php?utm_source=help


 

AKVIS HDRFactory — High Dynamic Range Images: Brighter than Reality!

(Windows | Mac)

AKVIS HDRFactory lets you create a High Dynamic Range image from a series of shots or from one single photo.
The program can also be used for photo correction. The program brings life and color to your photos! More…

 

AKVIS LightShop — Light and Star Effects

(Windows | Mac)

AKVIS LightShop lets you create an infinite number of astounding light effects! The program offers advanced
lighting techniques for adding stars and glow effects to images. A light effect draws attention and brighten up any
photo. Add a little magic to your pictures! More…
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AKVIS Magnifier AI — Change Image Size without Quality Loss

(Windows | Mac)

AKVIS Magnifier AI helps to resize images without loss in quality. Featuring neural networks based algorithms,
Magnifier AI enlarges digital pictures to super-high resolution and produces stunning wall-sized prints. More…

 

AKVIS MakeUp — Retouch Your Portrait Photos!

(Windows | Mac)

AKVIS MakeUp improves your portraits giving them a professional look. The software retouches facial
imperfections making your skin radiant, beautiful, pure and even. The program adds glamour to your pictures and
creates a high key effect. Look your best in every photo with AKVIS MakeUp! More…
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AKVIS NatureArt — Bring Nature to Your Photos

(Windows | Mac)

AKVIS NatureArt is an excellent tool for imitating the magnificence of natural phenomena on your photos. The
program includes a number of effects: Rain

 

AKVIS Neon — Glowing Drawings from Photos

(Windows | Mac)

AKVIS Neon lets you create amazing glowing lines effects. The software transforms a photo into a neon image
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that looks like drawn with luminescent ink. More…

 

AKVIS Noise Buster — Digital Noise Reduction

(Windows | Mac)

AKVIS Noise Buster is software for noise suppression on digital and scanned images. Digital noise can be seen as
artifacts and random red and blue pixels that compromise the smoothness of a photo. The program is efficient
against both color and luminance noise. More…

 

AKVIS OilPaint — Oil Painting Effect

(Windows | Mac)

AKVIS OilPaint turns your photos into oil paintings. The mysterious production of a painting happens right before
your eyes. The unique algorithm authentically reproduces the technique of the real brush. With this cutting-edge
software you can become a painter! More…
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AKVIS Pastel — Turn Photos into Pastel Paintings

(Windows | Mac)

AKVIS Pastel turns your photos into pastel paintings. The program converts your photo into a lifelike digital art
imitating one of the most popular artistic techniques. AKVIS Pastel is a powerful tool to unleash your creativity!
More…

 

AKVIS Points — Apply Pointillism Effect to Your Photos

(Windows | Mac)

AKVIS Points lets you transform your photos into paintings using one of the most exciting artistic techniques -
pointillism. With the software you can easily create gorgeous works of art in a pointillist manner. Discover the world
of bright colors! More…
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AKVIS Refocus — Focus Improvement & Blur Effects

(Windows | Mac)

AKVIS Refocus improves sharpness of out of focus photos, enhances the entire image or partially, creating
selectively focused area. It's also possible to add bokeh and lens blur effects to your photos. The program
provides five image processing modes: Refocus, Tilt-Shift, Iris Blur, Motion Blur, and Radial Blur. More…

 

AKVIS Retoucher — Image Restoration Software

(Windows | Mac)

AKVIS Retoucher is an efficient program for photo restoration and photo retouching. The software removes dust,
scratches, stains, and other defects that appear on damaged photos. It intelligently reconstructs the missing
parts of the photo using the information of the surrounding areas. More…
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AKVIS Sketch — Turn Your Photos into Pencil Sketches

(Windows | Mac)

AKVIS Sketch converts photos into amazing pencil drawings. The software creates realistic color artworks and
B&W sketches, imitating the technique of graphite and color pencil. The program offers these photo to drawing
conversion styles: Classic, Artistic, and Maestro, - each with a series of presets. AKVIS Sketch allows you to feel
like a real artist! More…

 

AKVIS SmartMask — Save Time on Complex Selections!
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https://akvis.com/en/smartmask/index.php?utm_source=help


(Windows | Mac)

AKVIS SmartMask is an efficient selection tool that saves time and is fun to use. Selection has never been so
simple! The software considerably increases your productivity. You will be freed from boring work and will have
more room for creativity and realization of your ideas. More…

 

AKVIS Watercolor — Aquarelle Art from Photos

(Windows | Mac)

AKVIS Watercolor easily makes a photo look like a brilliant and vibrant watercolor painting. The software turns
ordinary images into amazingly realistic aquarelle pieces of art. More…
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